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1

INTRODUCTION
TO MATLAB

MATLAB, developed by Math Works Inc., is a software package for high performance
numerical computation and visualization. The combination of analysis capabilities,
flexibility, reliability, and powerful graphics makes MATLAB the premier software
package for electrical engineers.

MATLAB provides an interactive environment with hundreds of reliable and ac-
curate built-in mathematical functions. These functions provide solutions to a broad
range of mathematical problems including matrix algebra, complex arithmetic, linear
systems, differential equations, signal processing, optimization, nonlinear systems,
and many other types of scientific computations. The most important feature of MAT-
LAB is its programming capability, which is very easy to learn and to use, and which
allows user-developed functions. It also allows access to Fortran algorithms and C
codes by means of external interfaces. There are several optional toolboxes written for
special applications such as signal processing, control systems design, system identi-
fication, statistics, neural networks, fuzzy logic, symbolic computations, and others.
MATLAB has been enhanced by the very powerful SIMULINK program. SIMULINK is
a graphical mouse-driven program for the simulation of dynamic systems. SIMULINK
enables students to simulate linear, as well as nonlinear, systems easily and efficiently.

The following section describes the use of MATLAB and is designed to give
a quick familiarization with some of the commands and capabilities of MATLAB.
For a description of all other commands, MATLAB functions, and many other useful
features, the reader is referred to the MATLAB User’s Guide.
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1.1 INSTALLING THE TEXT TOOLBOX

The software diskette included with the book contains all the developed functions
and chapter examples. The file names for chapter examples begin with the letters ch.
For example, the M-file for Example 2.4 is ch2ex04. Create a subdirectory, such as
HS, where the MATLABRI I toolbox resides. Copy all the files on the diskette to the
subdirectory MATLABR11 \TOOLBOX\HS.

In the MATLAB 5.3 Command Window open the Path Browser by selecting Set
Path from the File menu. Press to open the Add to Path window. Open the toolbox
folder and double-click on the HS folder. Choose Add to Back option and click on
Save Settings to save the new path permanently.

1.2 RUNNING MATLAB

MATLAB supports almost every computational platform. MATLAB for WINDOWS is
started by clicking on the MATLAB icon. The Command window is launched, and
after some messages such as intro, demo, help help, info, and others, the prompt “ >
”” is displayed. The program is in an interactive command mode. Typing who or whos
displays a list of variable names currently in memory. Also, the dir command lists
all the files on the default directory. MATLAB has an on-line help facility, and its use
is highly recommended. The command help provides a list of files, built-in functions
and operators for which on-line help is available. The command

help function name

will give information on the specified function as to its purpose and use. The command
help help

will give information as to how to use the on-line help.

MATLAB has a demonstration program that shows many of its features. The
command demo brings up a menu of the available demonstrations. This will provide
a presentation of the most important MATLAB facilities. Follow the instructions on
the screen — it is worth trying.

MATLAB 5.3 includes a Help Desk facility that provides access to on line help
topics, documentation, getting started with MATLAB, online reference materials, MAT-
LAB functions, real-time Workshop, and several toolboxes. The online documentation
is available in HTML, via either Netscape Navigator or Microsoft Internet Explorer.
The command helpdesk launches the Help Desk, or you can use the Help menu to
bring up the Help Desk.

If an expression with correct syntax is entered at the prompt in the Command
window, it is processed immediately and the result is displayed on the screen. If an
expression requires more than one line, the last character of the previous line must
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contain three dots “...”. Characters following the percent sign are ignored. The (%)
may be used anywhere in a program to add clarifying comments. This is especially
helpful when creating a program. The command clear erases all variables in the Com-
mand window.

MATLAB is also capable of executing sequences of commands that are stored in
files, known as script files or M-files. Clicking on File, Open M-file, opens the Edit
window. A program can be written and saved in ASCII format with a filename having
extension .m in the directory where MATLAB runs. To run the program, click on the
Command window and type the filename without the .m extension at the MATLAB
command “>>”. You can view the text Edit window simultaneously with the Com-
mand window. That is, you can use the two windows to edit and debug a script file
repeatedly and run it in the Command window without ever quitting MATLAB.

In addition to the Command window and Edit window are the Graphic windows
or Figure windows with grey (default) background. The plots created by the graphic
commands appear in these windows.

Another type of M-file is a function file. A function provides a convenient way
to encapsulate some computation, which can then be used without worrying about
its implementation. In contrast to the script file, a function file has a name following
the word “function” at the beginning of the file. The filename must be the same as
the “function” name. The first line of a function file must begin with the function
statement having the following syntax

function [output arguments] = function name (input arguments)

The output argument(s) are variables returned. A function need not return a value. The
input arguments are variables passed to the function. Variables generated in function
files are local to the function. The use of global variables make defined variables com-
mon and accessible between the main script file and other function files. For example,
the statement global R S T declares the variables R, S, and 7" to be global without
the need for passing the variables through the input list. This statement goes before
any executable statement in the script and function files that need to access the values
of the global variables.

Normally, while an M-file is executing, the commands of the file are not dis-
played on the screen. The command echo allows M-files to be viewed as they exe-
cute. echo off turns off the echoing of all script files. Typing what lists M-files and
Mat-files in the default directory.

MATLAB follows conventional Windows procedure. Information from the com-
mand screen can be printed by highlighting the desired text with the mouse and then
choosing the print Selected ... from the File menu. If no text is highlighted the en-
tire Command window is printed. Similarly, selecting print from the Figure window
sends the selected graph to the printer. For a complete list and help on general purpose
commands, type help general.
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1.3 VARIABLES

Expressions typed without a variable name are evaluated by MATLAB, and the result
is stored and displayed by a variable called ans. The result of an expression can be
assigned to a variable name for further use. Variable names can have as many as 19
characters (including letters and numbers). However, the first character of a variable
name must be a letter. MATLAB is case-sensitive. Lower and uppercase letters repre-
sent two different variables. The command casesen makes MATLAB insensitive to the
case. Variables in script files are global. The expressions are composed of operators
and any of the available functions. For example, if the following expression is typed

x = exp(-0.2696%.2)*sin(2*pi*0.2)/(0.01*sqrt(3)*1log(18))

the result is displayed on the screen as

18.0001

and is assigned to x. If a variable name is not used, the result is assigned to the
variable ans. For example, typing the expression

250/sin(pi/6)

results in

ans =
500.0000

If the last character of a statement is a semicolon (;), the expression is executed, but
the result is not displayed. However, the result is displayed upon entering the variable
name. The command disp may be used to display a variable without printing its name.
For example, disp(x) displays the value of the variable without printing its name. If x
contains a text string, the string is displayed.

1.4 OUTPUT FORMAT

While all computations in MATLAB are done in double precision, the default format
prints results with five significant digits. The format of the displayed output can be
controlled by the following commands.
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MATLAB Command

Display

format
format short
format long
format short e
format long e
format short g
format long g
format hex
format +

format bank
format rat
format compact
format loose

Default. Same as format short

Scaled fixed point format with 5 digits
Scaled fixed point format with 15 digits
Floating point format with 5 digits
Floating point format with 15 digits

Best of fixed or floating point with 5 digits
Best of fixed or floating point with 15 digits
Hexadecimal format

The symbols +, - and blank are printed for
positive, negative, and zero elements
Fixed format for dollars and cents
Approximation by ratio of small integers
Suppress extra line feeds

Puts the extra line feeds back in

For more flexibility in the output format, the command fprintf displays the result
with a desired format on the screen or to a specified filename. The general form of
this command is the following.

fprintf{fstr, A,...)

writes the real elements of the variable or matrix A, ... according to the specifi-
cations in the string argument of fstr. This string can contain format characters
like ANCI C with certain exceptions and extensions. fprintf is “vectorized” for the
case when A is nonscalar. The format string is recycled through the elements of A
(columnwise) until all the elements are used up. It is then recycled in a similar man-
ner through any additional matrix arguments. The characters used in the format string
of the commands fprintf are listed in the table below.

Format codes Control characters
%e  scientific format, lower case e \n new line
%E  scientific format, upper case E \r beginning of the line
%f  decimal format \b back space
%s  string \t tab
%u  integer \g new page
%i  follows the type 11 apostrophe
%x  hexadecimal, lower case \\ back slash
%X  hexadecimal, upper case \a bell

A simple example of the fprintf is

fprintf (’Area = J7.3f Square meters \n’, pi*4.572)

The results is
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Area = 63.617 Square meters

The %7.3f prints a floating point number seven characters wide, with three digits after
the decimal point. The sequence \n advances the output to the left margin on the next
line.

The following command displays a formatted table of the natural logarithmic for num-
bers 10, 20, 40, 60, and 80

x = [10; 20; 40; 60; 80];

y = [x, log(x)];

fprintf (’\n Number Natural log\n’)
fprintf (’%4i \t %8.3f\n’,y’)

The result is

Number  Natural log

10 2.303
20 2.996
40 3.689
60 4.094
80 4.382

An M-file can prompt for input from the keyboard. The command input causes
the computer to request data from the keyboard. For example, the command

R = input(’Enter radius in meter ’)
displays the text string
Enter radius in meter

and waits for a number to be entered. If a number, say 4.5 is entered, it is assigned to
variable R and displayed as

R =
4.5000

The command keyboard placed in an M-file will stop the execution of the file
and permit the user to examine and change variables in the file. Pressing cntrl-z ter-
minates the keyboard mode and returns to the invoking file. Another useful command
is diary A:filename. This command creates a file on drive A, and all output displayed
on the screen is sent to that file. diary off turns off the diary. The contents of this file
can be edited and used for merging with a word processor file. Finally, the command
save filename can be used to save the expressions on the screen to a file named file-
name.mat, and the statement load filename can be used to load the file filename.mat.

MATLAB has a useful collection of transcendental functions, such as exponen-
tial, logarithm, trigonometric, and hyperbolic functions. For a complete list and help
on operators, type help ops, and for elementary math functions, type help elfun.
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1.5 CHARACTER STRING

A sequence of characters in single quotes is called a character string or text variable.

¢ =’Good’
results in
¢ = Good

A text variable can be augmented with more text variables, for example,
cs = [c, ? luck’]
produces

cs =
Good luck

1.6 VECTOR OPERATIONS

An n vector is a row or a column array of n numbers. In MATLAB, elements enclosed
by brackets and separated by semicolons generate a column vector.
For example, the statement

X=1[2; -4; 8]
results in
X =
2
-4
8

If elements are separated by blanks or commas, a row vector is produced. Elements
may be any expression. The statement

R = [tan(pi/4) sqrt(9) -5]
results in the output

R =
1.0000 3.0000 -5.0000

The transpose of a column vector results in a row vector, and vice versa. For example

Y=R’
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will produce

Y =
1.0000
3.0000

-5.0000

MATLAB has two different types of arithmetic operations. Matrix arithmetic op-
erations are defined by the rules of linear algebra. Array arithmetic operations are
carried out element-by-element. The period character (.) distinguishes the array oper-
ations from the matrix operations. However, since the matrix and array operations are
the same for addition and subtraction, the character pairs .+ and .- are not used.

Vectors of the same size can be added or subtracted, where addition is performed
componentwise. However, for multiplication, specific rules must be followed in order
to obtain the correct resulting values. The operation of multiplying a vector X with a
scalar k (scalar multiplication) is performed componentwise. For example P = 5 * R
produces the output

P =
5.0000 15.0000 -25.0000

The inner product or the dot product of two vectors X and Y denoted by (X,Y) is
a scalar quantity defined by > i, z;y;. If X and Y are both column vectors defined
above, the inner product is given by

S = X’xY
and results in

S =
-50

The operator (.* performs element-by-element operation. For example, for the previ-
ously defined vectors, X and Y, the statement

E = X.*Y
results in
E -
2
-12
-40

The operator ./ performs element-by-element division. The two arrays must have the
same size, unless one of them is a scalar. Array powers or element-by-element powers
are denoted by ( . ~). The trigonometric functions, and other elementary mathematical
functions such as abs, sqrt, real, and log, also operate element by element.

Various norms (measure of size) of a vector can be obtained. For example, the Eu-
clidean norm is the square root of the inner product of the vector and itself. The
command
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N = norm(X)
produces the output

N =
9.1652

The angle between two vectors X and Y is defined by cos 8 = % The statement
Theta = acos( X’*Y/(norm(X)*norm(Y)) )
results in the output

Theta =
2.7444

where Theta is in radians.
The zero vector, also referred to as origin, is a vector with all components equal
to zero. For example, to build a zero row vector of size 4, the following command

Z = zeros(1l, 4)

results in

Z
0 0 0 0

The one vector is a vector with each component equal to one. To generate a one vector
of size 4, use

I = ones(1, 4)
The result is

I =

In MATLAB, the colon (:) can be used to generate a row vector. For example
x = 1:8

generates a row vector of integers from 1 to 8.

1 2 3 4 5 6 7 8
For increments other than unity, the following command
z =0 : pi/3 : pi

results in
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0000 1.0472 2.0944 3.1416

For negative increments

5 : -1:1

X

results in

X =

5 4 3 2 1

Alternatively, special vectors can be created, the command linspace(x, y, n) creates
a vector with n elements that are spaced linearly between x and y. Similarly, the
command logspace(x, y, n) creates a vector with n elements that are spaced in even
logarithmic increments between 10?7 and 10Y.

1.7 ELEMENTARY MATRIX OPERATIONS

In MATLAB, a matrix is created with a rectangular array of numbers surrounded by
brackets. The elements in each row are separated by blanks or commas. A semicolon
must be used to indicate the end of a row. Matrix elements can be any MATLAB
expression. The statement

A=[6 1 2; -1 8 3; 2 4 9]

results in the output

A=
6 1 2
-1 8 3
2 4 9

If a semicolon is not used, each row must be entered in a separate line as shown below.

A=1[6 1 2
-1 8 3
2 4 9]

The entire row or column of a matrix can be addressed by means of the symbol
(2). For example

r3 = A(3, :)

results in

r3 =
2 4 9

Similarly, the statement A(:, 2) addresses all elements of the second column in A.

Matrices of the same dimension can be added or subtracted. Two matrices, A
and B, can be multiplied together to form the product AB if they are conformable.
Two symbols are used for nonsingular matrix division. A\ B is equivalent to A~!B,
and A/B is equivalent to AB™!
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Example 1.1

For the matrix equation below, AX = B, determine the vector X .

4 -2 —10 T1 —10
2 10 —12 To | = 32
-4 —6 16 T3 —16

The following statements

A=1[4 -2 -10; 2 10 -12; -4 -6 16];
B = [-10; 32; -16];
X = A\B

result in the output

X =
2.0000
4.0000
1.0000

In addition to the built-in functions, numerous mathematical functions are avail-
able in the form of M-files. For the current list and their applications, see the MATLAB
User’s Guide.

Example 1.2

Use the inv function to determine the inverse of matrix A in Example 1.1 and then
determine X . The following statements

A=1[4 -2 -10; 2 10 -12; -4 -6 16];
B = [-10; 32; -16];

C = inv(A)

X = CxB

result in the output

C =
2.2000 2.3000 3.1000
0.4000 0.6000 0.7000
0.7000 0.8000 1.1000

X =

2.0000
4.0000
1.0000

Example 1.3

Use the lu factorization function to express the matrix A of Example 1.2 as the product
of upper and lower triangular matrices, A = LU. Then find X from X = U~'L~!B.

Typing
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A=[4 -2 -10; 2 10 -12; -4 -6 16 1]

B = [-10; 32 -16];
[L,U] = 1u(A)
results in

L =
1.0000 0 0
0.5000 1.0000 0
-1.0000 -0.7273 1.0000

U =

4.0000 -2.0000 -10.0000
0 11.0000 -7.0000

0 0 0.9091
Now entering
X = inv(U)*inv (L) *B
results in
X -
2.0000
4.0000
1.0000

Dimensioning is automatic in MATLAB. You can find the dimensions and rank of
an existing matrix with the size and rank statements. For vectors, use the command
length.

1.7.1 UTILITY MATRICES

There are many special utility matrices which are useful for matrix operations. A few
examples are

eye(m, n) Generates an m-by-n identity matrix.
zeros(m, n) Generates an m-by-n matrix of zeros.
ones(m, n)  Generates an m-by-n matrix of ones.
diag(x) Produces a diagonal matrix with the
elements of x on the diagonal line.

For a complete list and help on elementary matrices and matrix manipulation, type
help elmat. There are many other special built-in matrices. For a complete list and
help on specialized matrices, type help specmat.

1.7.2 EIGENVALUES

If A is an n-by-n matrix, the n numbers A that satisfy Az = Az are the eigenvalues
of A. They are found using eig(A), which returns the eigenvalues in a column vector.
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Eigenvalues and eigenvectors can be obtained with a double assignment statement
[X, D] = eig(A). The diagonal elements of D are the eigenvalues and the columns
of X are the corresponding eigenvectors such that AX = X D.

Example 1.4

Find the eigenvalues and the eigenvectors of the matrix A given by

0 1 -1
A=1| —6 —11 6
—6 —11 )

A=[0 1 -1; -6 -11 6; -6 -11 5];
[X,D] = eig(A)

The eigenvalues and the eigenvectors are obtained as follows

X = D =
-0.7071 0.2182 -0.0921 -1 0 0
0.0000 0.4364 -0.5523 o -2 0
-0.7071 0.8729 -0.8285 0 0 -3

1.8 COMPLEX NUMBERS

All the MATLAB arithmetic operators are available for complex operations. The imag-
inary unit v/—1 is predefined by two variables i and j. In a program, if other values
are assigned to ¢ and 7, they must be redefined as imaginary units, or other characters
can be defined for the imaginary unit.

j = sqrt(-1) or i = sqrt(-1)
Once the complex unit has been defined, complex numbers can be generated.

Example 1.5
Evaluate the following function V' = Zc¢ cosh g+sinh g/Zc, where Zc¢ = 200+ ;300
and g = 0.02 + 51.5

i = sqrt(-1); Zc = 200 + 300%i; g = 0.02 + 1.5%i;
v Zc *cosh(g) + sinh(g)/Zc

results in the output

v =

8.1672 + 25.2172i

It is important to note that, when complex numbers are entered as matrix elements
within brackets, we avoid any blank spaces. If spaces are provided around the complex
number sign, it represents two separate numbers.
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Example 1.6

In the circuit shown in Figure 1.1, determine the node voltages V; and V> and the
power delivered by each source.

%1 y12 = 0.35 — 51.2 Vs
AAAA— A

30 + j40A _ _ 20 + j15A
Y10 = Y20 =
D 1.15 - j0.8  0.55 — ;0.4 (T

FIGURE 1.1
Circuit for Example 1.6.

Kirchhoff’s current law results in the following matrix node equation.

1.5—520 =354+ 121 Vi ] _ [ 30+ ;40
—.35+ 1.2 0.9—41.6 | | Vo | = | 20+ 415

and the complex power of each source is given by S = V I*. The following program
is written to yield solutions to V; ,V5 and S using MATLAB.

j=sqrt(-1) % Defining j
I=[30+j*40; 20+j*15] % Column of node current phasors
Y=[1.5-j*%2 -.35+j*1.2; -.35+j*1.2 .9-j*1.6]

% Complex admittance matrix Y
disp(’The solution is’) V=inv(Y)*I % Node voltage solution
S=V.x*conj(I) % complex power at nodes

result in

The solution is

Vv =
3.5902 + 35.0928i
6.0155 + 36.2212i
S =
1511.4 + 909.2i

663.6 + 634.2i

In MATLAB, the conversion between polar and rectangular forms makes use of the
following functions:
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Operation Description
z=a-+biorz=a-+j*b Rectangular from

real(z) Returns real part of z

imag(z) Returns imaginary part of z
abs(z) Absolute value of z

angle(z) Phase angle of z

conj(z) Conjugate of 2z

z =M *exp(j*0) converts M /6 to rectangular form

The prime (') transposes a real matrix; but for complex matrices, the symbol (.") must
be used to find the transpose.

1.9 POLYNOMIAL ROOTS
AND CHARACTERISTIC POLYNOMIAL

If p is a row vector containing the coefficients of a polynomial, roots(p) returns a
column vector whose elements are the roots of the polynomial. If 7 is a column vector
containing the roots of a polynomial, poly(r) returns a row vector whose elements are
the coefficients of the polynomial.

Example 1.7

Find the roots of the following polynomial.

s% +95% + 31.255% + 61.255% + 67.755% + 14.75s + 15

The polynomial coefficients are entered in a row vector in descending powers.
The roots are found using roots.

[1 9 31.25 61.25 67.75 14.75 15 ]
roots(p)

p
r

The polynomial roots are obtained in column vector

r =
-4.0000
-3.0000
-1.0000 + 2.00001
-1.0000 - 2.00001
0.0000 + 0.50001
0.0000 - 0.50001
Example 1.8

The roots of a polynomial are —1, —2, —3 £ j4. Determine the polynomial equation.
Complex numbers may be entered using function ¢ or j. The roots are then
entered in a column vector. The polynomial equation is obtained using poly as follows
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i = sqrt(-1)
r=[-1 -2 -3+4%i -3-4%i ]
p = poly(r)

The coefficients of the polynomial equation are obtained in a row vector.

p=
1 9 45 87 650

Therefore, the polynomial equation is

st 4+ 983 + 4552 + 875 +50 = 0

Example 1.9

Determine the roots of the characteristic equation of the following matrix.
0 1 -1
A= { —6 —11 6 -I
[ —6 —11 5 J

The characteristic equation of the matrix is found by poly, and the roots of this equa-
tion are found by roots.

A=[0 1 -1; -6 -11 6; -6 -11 5];
p = poly(A)
r = roots(p)

The result is as follows

p =
1.0000 6.0000 11.0000 6.0000
r = -3.0000
-2.0000
-1.0000

The roots of the characteristic equation are the same as the eigenvalues of matrix A.
Thus, in place of the poly and roots function, we may use

r = eig(h)

1.9.1 PRODUCT AND DIVISION OF POLYNOMIALS

The product of polynomials is the convolution of the coefficients. The division of
polynomials is obtained by using the deconvolution command.
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Example 1.10

(a) Given A = s + 7s + 12, and B = s> 4+ 9, find C = AB.
(b) Given Z = s* 4 953 + 375> + 81s + 52, and Y = s? + 45 + 13, find X = £.

The commands

A =11 7 12]; B = [1 0 9];

C conv(A, B)

Z =11 9 37 81 52]; Y = [1 4 13];
[X, r] = deconv(Z, Y)

result in
C =
1 7 21 63 108
X =
1 5 4
r =
0O 0 O

1.9.2 POLYNOMIAL CURVE FITTING
In general, a polynomial fit to data in vector z and y is a function p of the form
p(z) = izt + ez - 4 ey

The degree is d, and the number of coefficients is n = d+1. Given a set of points
in vectors x and y, polyfit(x, y, d) returns the coefficients of dth order polynomial in
descending powers of x.

Example 1.11
Find a polynomial of degree 3 to fit the following data

r |0 1 2 4 6 10

y |1 7 23 109 307 1231
x=[0 1 2 4 6 10];
y=[1 7 23 109 307 1231];
¢ = polyfit(x,y,3)

The coefficients of a third degree polynomial are found as follows

C =
1.0000 2.0000 3.0000 1.0000

ie,y=a3+22%+ 31+ 1.
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1.9.3 POLYNOMIAL EVALUATION

If c is a vector whose elements are the coefficients of a polynomial in descending
powers, the polyval(c, x) is the value of the polynomial evaluated at x. For example,
to evaluate the above polynomial at points O, 1, 2, 3, and 4, use the commands

c=1[1 2 3 11;
x = 0:1:4;
y = polyval(c, x)

which result in

y =
7 23 55 109
1.94 PARTIAL-FRACTION EXPANSION

[, p, k] = residue[b, a] finds the residues, poles, and direct terms of a partial fraction
expansion of the ratio of two polynomials

P(s) _ byps™ +bp18™1 + -+ bys + by
Q(s)  ans" +ap_15" + - +ais+ap

Vectors b and a specify the coefficients of the polynomials in descending powers of
s. The residues are returned in column vector r, the pole locations in column vector
p. and the direct terms in row vector k.

Example 1.12
Determine the partial fraction expansion for

288495 +1
B3+ s244s+4

F(s)

b=[2 0 9 1];
a=[1 1 4 4];
[r,p,k] = residue(b,a)

The result is as follows

r =
0.0000 -0.25001
0.0000 +0.25001

-2.0000

p =
0.0000 +2.0000i
0.0000 -2.00001

-1.0000

K =

2.0000



Therefore the partial fraction expansion is

2+

mial P(s)/Q(s).

For a complete list and help on matrix analysis, linear equations, eigenvalues,

—2 025  —j0.25 )
J J220 gy

s+1 s+452  s—42 s+1

[b, a] = residue(r, p, K) converts the partial fraction expansion back to the polyno-

and matrix functions, type help matfun.

1.10 GRAPHICS

MATLAB can create high-resolution, publication-quality 2-D, 3-D, linear, semilog,
log, polar, bar chart and contour plots on plotters, dot-matrix printers, and laser print-
ers. Some of the 2-D graph types are plot, loglog, semilogx, semi -logy, polar, and
bar. The syntax for the above plots includes the following optional symbols and col-

ors.
COLOR SPECIFICATION | LINE STYLE-OPTION
Long name  Short name | Style Symbol
black k solid -
blue b dashed --
cyan c dotted
green g dash-dot -
magenta m point .
red r circle 0
white w x-mark X
yellow y plus +

star *

Some of the Specialized 2-D plots are listed below:

area
bar

barh
comet
ezplot
ezpolar
feather
fill

fplot

hist
pareto
pie
plotmatrix
stem
stairs

Filled area plot

Bar graph

Horizontal bar graph

Comet-like trajectory

Easy to use function plotter
Easy to use polar coordinate plotter
Feather plot

Filled 2-D polygons

Plot function

Histogram

Pareto chart

Pie chart

Scatter plot matrix

Discrete sequence or “’stem” plot
Stairstep plot

1.10. GRAPHICS
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You have three options for plotting multiple curves on the same graph. For example,
plot(x1l, yi,’r’, x2, y2, ’+b’, x3, y3, ’-=?)

plots (x1, y1) withasolid red line, (x2, y2) with a blue + mark, and (x3, y3)
with a dashed line. If X and Y are matrices of the same size, plot(X, Y) will plot the
columns of Y versus the column of X.

Alternatively, the hold command can be used to place new plots on the previous
graph. hold on holds the current plot and all axes properties; subsequent plot com-
mands are added to the existing graph. hold off returns to the default mode whereby
a new plot command replaces the previous plot. hold, by itself, toggles the hold state.

Another way for plotting multiple curves on the same graph is the use of the
line command. For example, if a graph is generated by the command plot(x1,
y1), then the commands

line(x2, y2, ’+b’)
line(x3, y3, ’--’)

Add curve (x2, y2) with a blue + mark, and (x2, y2) with a dashed line to the
existing graph generated by the previous plot command. Multiple figure windows can
be created by the figure command. figure, by itself, opens a new figure window, and
returns the next available figure number, known as the figure handle. figure(h) makes
the figure with handle h the current figure for subsequent plotting commands. Plots
may be annotated with title, x — y labels and grid. The command grid adds a grid
to the graph. The commands title(’ Graph title ) titles the plot, and xlabel(’x-axis
label ), ylabel(’y-axis label ) label the plot with the specified string argument. The
command text(x-coordinate, y-coordinate, ’text’) can be used for placing text on the
graph, where the coordinate values are taken from the current plot. For example, the
statement

text(3.5, 1.5, ’Voltage’)

will write Voltage at point (3.5, 1.5) in the current plot. Alternatively, you can use the
gtext(’fext’) command for interactive labeling. Using this command after a plot pro-
vides a crosshair in the Figure window and lets the user specify the location of the text
by clicking the mouse at the desired location. Finally, the command legend(stringl,
string2, string3, ...) may be used to place a legend on the current plot using the spec-
ified strings as labels. This command has many optional arguments. For example,
legend( linetypel, stringl, linetype2, string2, linetype3, string3, ...) specifies the line
types/color for each label at a suitable location. However, you can move the legend
to a desired location with the mouse. legend off removes the legend from the current
axes.

MATLAB provides automatic scaling. The command axis([x min. x max. y min.
y max.]) enforces the manual scaling. For example

axis([-10 40 -60 60])
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produces an z-axis scale from —10 to 40 and a y-axis scale from —60 to 60. Typing
axis again or axis(’auto’) resumes auto scaling. Also, the aspect ratio of the plot can
be made equal to one with the command axis(’square’). With a square aspect ratio,
a line with slope 1 is at a true 45 degree angle. axis(’equal’) will make the z- and
y-axis scaling factor and tic mark increments the same. For a complete list and help
on general purpose graphic functions, and two- and three-dimensional graphics, see
help graphics, help plotxy, and help plotxyz.

There are many other specialized commands for two-dimensional plotting. Among
the most useful are the semilogx and semilogy, which produce a plot with an z-axis
log scale and a y-axis log scale. An interesting graphic command is the comet plot.
The command comet(x, y) plots the data in vectors x and y with a comet moving
through the data points, and you can see the curve as it is being plotted. For a complete
list and help on general purpose graphic functions and two-dimensional graphics, see
help graphics and help plotxy.

1.11 GRAPHICS HARD COPY

The easiest way to obtain hard-copy printout is to make use of the Windows built-in
facilities. In the Figure window, you can pull down the file menu and click on the
Print command to send the current graph directly to the printer. You can also import
a graph to your favorite word processor. To do this, select Copy options from the Edit
pull-down menu, and check mark the Invert background option in the dialog box to
invert the background. Then, use Copy command to copy the graph into the clipboard.
Launch your word processor and use the Paste command to import the graph.

Some word processors may not provide the extensive support of the Windows
graphics and the captured graph may be corrupted in color. To eliminate this problem
use the command

system dependent (14, ’on’)

which sets the metafile rendering to the lowest common denominator. To set the
metafile rendering to normal, use

system_dependent (14, ’off’)

In addition MATLAB provides a function called print that can be used to pro-
duce high resolution graphic files. For example,

print -dhpgl [filename]

saves the graph under the specified filename with extension hgl. This file may be pro-
cessed with an HPGL- compatible plotter. Similarly, the command

print -dilll [filename]
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produces a graphic file compatible with the Adobe Illustrator’88. Another print op-
tion allows you to save and reload a figure. The command

print -dmfile [ filename ]

produces a MAT file and M-file to reproduce the figure again.

In the Figure window, from the File pull-down menu you can use Save As... to save
the figure with extension fig. This file can be opened in the Figure window again.
Also, from the File pull-down menu you can use Expert... to save the graph in several
different format, such as: emf, bmp, eps, ai, jpg, tiff, png, pcx, pbm, pgm, and ppm
extensions.

Example 1.13

Create a linear X-Y plot for the following variables.

z| 0 05 10 15 20 25 30 35 40 45 50
y|10 10 16 24 30 38 52 68 82 96 123

For a small amount of data, you can type in data explicitly using brackets.

x=[0 0.5 1.0 1.5 2.0 2.5 3.0 3.5 4.0 4.5 5.0];
y = [10 10 16 24 30 38 52 68 82 96 123];
plot(x, y), grid

xlabel(’x’), ylabel(’y’), title(’A simple plot example’)

plot(x, y) produces a linear plot of y versus  on the screen, as shown in Figure 1.2.

For large amounts of data, use the text editor to create a file with extension m. Typing
the filename creates your data in the workspace.

Example 1.14

Fit a polynomial of order 2 to the data in Example 1.13. Plot the given data point with
symbol x, and the fitted curve with a solid line. Place a boxed legend on the graph.

The command p = polyfit(x, y, 2) is used to find the coefficients of a polynomial
of degree 2 that fits the data, and the command yc = polyval(p, x) is used to evaluate
the polynomial at all values in x. We use the following command.

x=[0 0.5 1.0 1.5 2.0 2.5 3.0 3.5 4.0 4.5 5.0];
y=1[10 10 16 24 30 38 52 68 82 96 123];
p = polyfit(x, y, 2) % finds the coefficients of a polynomial

% of degree 2 that fits the data
yc = polyval(p, x);%polynomial is evaluated at all points in x
plot(x, y,’x’, x, yc)hplots data with x and fitted polynomial
xlabel(’x’), ylabel(’y’), grid
title(’Polynomial curve fitting’)
legend(’Actual data’, ’Fitted polynomial’, 4)
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A simple plot example
140 - - ' '

120

100

80

60

40

20

FIGURE 1.2
Example of X-Y plot.

The result is the array of coefficients of the polynomial of degree 2, and is

p =
4.0232 2.0107 9.6783

Thus, the parabola 4.022 + 2.0z + 9.68 is found that fits the given data in the
least-square sense. The plots are shown in Figure 1.3.

Example 1.15

Plot function y = 1 + e 2! sin(8¢ — 7/2) from 0 to 3 seconds. Find the time cor-
responding to the peak value of the function and the peak value. The graph is to be
labeled, titled, and have grid lines displayed.

Remember to use . * for the element-by-element multiplication of the two terms in the
given equation. The command [cp, k] = max(c) returns the peak value and the index
k corresponding to the peak time. We use the following commands.

t=0:.005:3; c = 1+ exp(-2*t) .*sin(8*t - pi/2);

[cp, k] = max(c) % cp is the maximum value of c¢ at interval k

tp = t(k) % tp is the peak time

plot(t, c), xlabel(’ t - sec’), ylabel(’c’), grid

title(’Damped sine curve’)

text (0.6, 1.4, [’cp =’,num2str(cp)])%Text in quote & the value
% of cp are printed at the specified location

text (0.6, 1.3, [’tp = ’,num2str(tp)])
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Polynomial curve fitting
140 . . . .

120

100

80

60

40

20

x  Actual data

—— Fitted polynomial

0 1 2 3 4 5

FIGURE 1.3
Fitting a parabola to the data in Example 1.13.

The result is

cp =
1.4702
k =
73
tp =
0.3600

and the plot is shown in Figure 1.4.

An interactive way to find the data points on the curve is by using the ginput
command. Entering [Xx, y] = ginput will put a crosshair on the graph. Position the
crosshair at the desired location on the curve, and click the mouse. You can repeat
this procedure for extracting coordinates for as many points as required. When the
return key is pressed, the input is terminated and the extracted data is printed on the
command menu. For example, to find the peak value and the peak time for the function
in Example 1.15, try

[tp, cp] = ginput
A crosshair will appear. Move the crosshair to the peak position, and click the mouse.

Press the return key to get

cp =
1.47

tp =
0.36
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Damped sine curve

1.5 T T T T T
cp = 1.4702
tp=0.36
1k
(&)
051 i
0 1 1 1 1 1
0 0.5 1 1.5 2 2.5 3
t. sec
FIGURE 14

Graph of Example 1.15.

subplot splits the Figure window into multiple portions, in order to show several plots
at the same time. The statement subplot(m, n, p) breaks the Figure window into an -
by-n box and uses the pth box for the subsequent plot. Thus, the command subplot(2,
2, 3), plot(x,y) divides the Figure window into four subwindows and plots y versus x
in the third subwindow, which is the first subwindow in the second row. The command
subplot(111) returns to the default Figure window. This is demonstrated in the next
example.

Example 1.16

Divide the Figure window into four partitions, and plot the following functions for wt
from 0 to 3 in steps of 0.05.

1. Plot v = 120sinwt and ¢ = 100sin(wt — m/4) versus wt on the upper left
portion.
2. Plot p = vt on the upper right portion.

3. Given F,,, = 3.0, plot f, = Fy,sinwt, F, = Fp, sin(wt — 27/3), and F, =
F,, sin(wt — 47 /3) versus wt on the lower left portion.

4. For fr = 3F,,, construct a circle of radius fr on the lower right portion.

wt = 0: 0.05: 3*pi; v=120*sin(wt); %Sinusoidal voltage
i = 100*sin(wt - pi/4); %Sinusoidal current
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Voltage & current Power
150 15000
100
10000
50
0 5000
-50
0
-100
-150 -5000
0 5 10 0 5 10
ot, radians ot, radians
3-phase mmf Rotating mmf
3 5
2
1
0 0
-1
-2
-3 -5
0 5 10 -5 0 5
ot, radians
FIGURE 1.5

Subplot demonstration.

P = V.*i; %Instantaneous power
subplot (2, 2, 1), plot(wt, v, wt, i); %Plot of v & i versus wt
title(’Voltage & current’), xlabel(’\omegat, radians’);

subplot(2, 2, 2), plot(wt, p); % Instantaneous power vs. wt
title(’Power’), xlabel(’ \omegat, radians ’)

Fm=3.0;

fa = Fm*sin(wt); % Three-phase mmf’s fa, fb, fc

fb = Fm*sin(wt - 2%pi/3); fc = Fm*sin(wt - 4%pi/3);
subplot(2, 2, 3), plot(wt, fa, wt, fb, wt, fc)
title(’3-phase mmf’), xlabel(’ \omegat, radians ’)
fR = 3/2%Fm;

subplot (2, 2, 4), plot(-fRxcos(wt), fR*sin(wt))
title(’Rotating mmf’), subplot(111)

Example 1.16 results are shown in Figure 1.5.
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1.12 THREE-DIMENSIONAL PLOTS

MATLAB provides extensive facilities for visualization of three-dimensional data. The
most common are plots of curves in a three-dimensional space, mesh plots, surface
plots, and contour plots. The command plot3(x, y, z , ’style option’) produces a curve
in the three-dimensional space. The viewing angle may be specified by the command
view(azimuth, elevation). The arguments azimuth, and elevation specifies the horizon-
tal and vertical rotation in degrees, respectively. The title, xlabel, ylabel, etc., may be
used for three-dimensional plots. The mesh and surf commands have several optional
arguments and are used for plotting meshes and surfaces. The contour(z) command
creates a contour plot of matrix z, treating the values in z as heights above the plane.
The statement mesh(z) creates a three-dimensional plot of the elements in matrix z.
A mesh surface is defined by the z coordinates of points above a rectangular grid in
the x-y plane. The plot is formed by joining adjacent points with straight lines. mesh-
grid transforms the domain specified by vector x and y into arrays X and Y. For a
complete list and help on general purpose Graphic functions and three-dimensional
graphics, see help graphics and help plotxyz. Also type demo to open the MATLAB
Expo Menu Map and visit MATLAB. Select and observe the demos in the Visualiza-
tion section.

Following is a list of elementary 3-D plots and some specialized 3-D graphs.

plot3 Plot lines and points in 3-D space
mesh 3-D mesh surface

surf 3-D colored surface

fill3 Filled 3-D polygons

comet3 3-D comet-like trajectories

ezgraph3  General purpose surface plotter

ezmesh  Easy to use 3-D mesh plotter

ezmeshc  Easy to use combination mesh/contour plotter
ezplot3 Easy to use 3-D parametric curve plotter

ezsurf Easy to use 3-D colored surface plotter
ezsurfc Easy to use combination surf/contour plotter
meshc Combination mesh/contour plot

meshz 3-D mesh with curtain

scatter3  3-D scatter plot

stem3 3-D stem plot

surfc Combination surf/contour plot

trisurf Triangular surface plot

trimesh Triangular mesh plot
cylinder  Generate cylinder
sphere Generate sphere

Example 1.17 chlex17.m

Few examples of 3-D plots and mesh plots are given in Figure 1.6.
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Plot of a parametric space curve

(1) = e—0.031 -0.03t

cost, y(t)=e sint, z(t)=t

t= 0:0.1:16™pi;
x=exp(-0.03*t).*cos(t);
y=exp(-0.03"t).*sin(t);
z=t;

plot3(x, y, z), axis off

2 205
Plot of function z=sinx cosy e * ™~

using mesh
t=-4:0.3:4; ’/%\\
[x,y] = meshgrid(t,t);

z = sin(x).*cos(y).*exp(—(x.A2+y.A2).10.5);
mesh(x,y,z), axis off ~

Plot of function z=—0. 1/(X2+y2+1)
using meshz

x=-3:0.3:3; y=X;

[X, y]=meshgrid(x,y);
z=-0.1./(x."2+y. 2+.1);
meshz(z) , axis off

view(-35, 60)

Discrete plot of

0.1t
xX=t, y=tcost, z=e
using stem3
t=0:.2:20;
x=t; y=t.*cos(t);
z=exp(0.1™1);
stem3(x,y,z), axis off
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Cylindrical surface created by
p=3+sint

using cylinder function

t=0:pi/5:6™pi;

p=3+sin(t);

cylinder(p), axis off

Plot of a unit sphere and a scaled sphere
using sphere function
[X,y,z]=sphere(24);

subplot(2,2,2), surf(x-2, y-2, z-1);
hold on

surf(2*x, 2*y,2*z);

axis off

Cartezian plot of Bessel function
JO[x2+y2]1/2 —12<x<I2, —12<y<I2
[X,y]=meshgrid(-12:.7:12, -12:.7:12);

r=sqrt(x.2+y.2);z= bessel(0,r);
m=[-45 60]; mesh(z,m), axis off

Contour lines and directional vectors 3 :
using contour and quiver functions Y SR Y
[X,y,z]=peaks(20); 2 L {7 (' XX
[nx, ny]=gradient(z,1,1); e A\X \ﬁ) SR
1 S VA 5 0 U S D
contour(x,y,z,10) B LI =
hold on VAN VD AR
; of - N
quiver(x,y,nx,ny) LN N
VADINNA L0
.| RN LS
VAN s,
) ] 7:
[ T S
_3 L
-2 0 2
FIGURE 1.6

Graphs of Example 1.17.
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For more specialized 3-D graphs and color related functions see help specgraph.

1.13 HANDLE GRAPHICS

It is often desirable to be able to customize the graphical output. MATLAB allows
object-oriented programming, enabling the user to have complete control over the
details of a graph. MATLAB provides many low-level commands known as Handle
Graphics. These commands makes it possible to access individual objects and their
properties and change any property of an object without affecting other properties or
objects. Handle Graphics provides a graphical user interface (GUI) in which the user
interface includes push buttons and menus. These topics are not discussed here; like
MATLAB syntax, they are easy to follow, and we leave these topics for the interested
reader to explore.

1.14 LOOPS AND LOGICAL STATEMENTS

MATLAB provides loops and logical statements for programming, like for, while,
and if statements. The for statement instructs the computer to perform all subsequent
expressions up to the end statement for a specified number of counted times. The
expression may be a matrix. The following is an example of a nested loop.

for i = 1:n, for j = 1:n
expression
end, end

The while statement allows statements to be repeated an indefinite number of
times under the control of a logic statement. The if, else, and elseif statements allow
conditional execution of statements. MATLAB has six relational operators and four
logical operators, which are defined in the following table.

Relational Operator Logical Operator
== equal &  logical AND
~= not equal |  logical OR
< less than ~  logical complement
<= less than or equal to xor exclusive OR
>  greater than
>=greater than or equal to

MATLAB is an interpreted language and macro operations such as matrices
multiplies faster than micro operations such as incrementing an index, and use of
loops are somewhat inefficient. Since variables in MATLAB are arrays and matrices,
try to use vector operations as much as possible instead of loops. The loops should
be used mainly for control operations. The use of loops are demonstrated in the next
four examples.
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Example 1.18

A rectangular signal can be represented as a series sum of harmonically related sine
or cosine signals. Consider the partial sum of the following periodic signals (Fourier
series).

4 . 1. 1.
z(t) = —[sinwot + 3 sin 3wot + g sin Swot + - - ]
i
4 X1, . .
=— Z — sin nwypt n 1is an odd integer
Tn

The following simple MATLAB statements uses a loop to generate this sum for any
given odd integer.

input (’Enter an odd integer’);
= 0:.01:2x%pi;

or k = 1:2:n;
X x + 1/k*sin(k*w_Ot);
end
x=4/pi*x;
plot(w_0Ot, x), xlabel(’\omega_Ot’)
text(3.5,.7,[’Sum of ’, num2str((n+1)/2),’ sine waves’])

The result for n = 101 is plotted as shown in Figure 1.7.

1.5 T T T T T T

1 v i
?j Sum of 51 sine waves

FIGURE 1.7
Graph 0f Example 1.18.

Example 1.19

A network function known as transfer function is expressed by

F(s) ans™ + ap_18" M+ +as+ag
S) =
bnsn + bn—lsn_l +---+ blS + b[)
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(a) write a MATLAB function named "mybode’ to evaluate the magnitude and phase
angle of the above function for s = jw where 0 < w < oo.

(b) Write a script function that uses *'mybode’ to evaluate the magnitude and phase

angle of
1000(s + 1)

F
() 511057 + 10005
over a logarithmic range of 0.1 < w < 1000.

The following function make use of two simple loops to sum up the numerator and
denominator terms and returns an array containing magnitudes and phase angles in
degree over the specified range.

% The function mybode returns the magnitude and phase
% angle of the frequency response transfer function.
% num and den are the numerator and denominator
% coefficients in descending order. w is the frequency
% array in rad/sec.
function[mag, phase] = mybode(num, den, w);
m=length(num); n=length(den);
N=num(m) ; D=den(n);
S=j*w;
for k=1:m-1
N=N+num(m-k) *s. "k;
end
for k=1:n-1
D=D+den(n-k)*s. “k;
end
H=N./D;
mag=abs (H) ;
phase=angle (H) *180/pi;

(b) The following script file uses 'mybode’ to evaluate and plot the magnitude and
phase angle of the function given (b) over the specified range of frequency.

num=[1000 1000], den=[1 110 1000 1];

w=logspace(-1, 3); % logarithmic range from 0.1 to 1000
[mag, phase]=mybode(num, den, w);

subplot(2,1,1), semilogx(w, mag), grid

xlabel(’\omega’), ylabel(’Magnitude’)

subplot(2,1,2), semilogx(w, phase), grid
xlabel(’\omega’), ylabel(’\theta, degree’)

The result is shown in Figure 1.8.

The MATLAB control system toolbox has a function called bode which obtains the
frequency response plots of a given transfer function. This function is used in Chapters
4 and 7.
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Magnitude
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FIGURE 1.8

Magnitude and phase angle plots for Example 1.19.

Example 1.20

Another example of loops is in the numerical solution of differential equations. Euler’s
method is the simplest and the least accurate of all numerical methods. Consider the
following simple one-dimensional first-order system.

dx+
a1— +apxr =c
L 0

rewriting in the form

dz c ap

If at ¢, the value of x(¢y) denoted by z is given,the subsequent values of x can be
determined by
dz
= —| At
A k+1 T + d + .
By applying the above algorithm successively, we can find approximate values of z(t)

at enough points from an initial state (£, zo) to a final state (¢, z ). Euler’s method
assumes that the derivative is constant over the entire interval At. An improvement
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can be obtained by calculating the derivative at both the beginning and end of inter-
vals, and then using their average value. This algorithm known as the modified Euler’s
method is given by

dx

dt

dx

dt

p

Tkt | A¢

Tk

Use the above algorithm to find the numerical solution of the following differential
equation, and plot the result up to a final time of ¢ = 15 seconds in steps of 0.01
second.

dz(t .

4 d(t) + 2z(t) = 10sin 8t given, zp=1
we use the following statements
al = 4; a0 = 2;
x0 = 1; t0 = 0; % Initial state
Dt = 0.01; tf=15; % Step size and final time
t=[1; x=[1; % Initializing all the arrays

np = (tf -t0)/Dt;

t(1) = t0; x(1) = x0;

for k=1:np
c=10*sin(pi*t(k));
t(k+1)=t(k)+Dt;

Dxl= c/al - a0/al*x(k); % Derivative at the beginning
x(k+1)=x(k)+Dx1*Dt; % Predicted value
Dx2=c/al - a0/al*x(k+1); % Derivative at the end of interval
Dxavg=(Dx1+Dx2)/2; % Average value of the two derivatives
x(k+1)=x(k) + DxavgxDt; % Corrected value

end
plot(t, x), grid
xlabel(’t, sec’), ylabel(’x(t)’)

The result is shown in Figure 1.9.

MATLAB provides several powerful functions for the numerical solution of dif-
ferential equations. Two of the functions employing the Runge-Kutta-Fehlberg meth-
ods are ode23 and ode45, based on the Fehlberg second- and third-order pair of for-
mulas for medium accuracy and forth- and fifth-order pair for higher accuracy. These
functions are described and utilized in Chapter 2.

Example 1.21

Consider the system of n equations in n variables
f1($1,$2, Tt 7$n) =C
f2($1,$2, o ,fL‘n) = C2
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0 5 t, sec 10 15

FIGURE 1.9
Numerical solution of Example 1.20.

The most widely used method for solving simultaneous nonlinear algebraic
equations is the Newton-Raphson method. Newton’s method is a successive approxi-
mation procedure based on an initial estimate of the unknown and the use of Taylor’s
series expansion and is given by

Xwﬂ):qukpmy4Acw

where J(*) is a matrix whose elements are the partial derivatives of F(*) and AC¥)
is

ACH =¢ - F®

The iteration procedure is initiated by assuming an approximate solution for

each of the independent variables (x§°’ , :cho) e x%o)). At the end of each iteration, the
calculated values of all variables are tested against the previous values. If all changes
in the variables are within the specified accuracy, a solution has converged, otherwise
another iteration must be performed.

Starting with the initial values, 1 = 1, zo = 1, and 3 = 1, solve the following
system of equations by the Newton-Raphson method.

i —a3+xi = 11

Tr1T9 + x% —3x3 =

L1 — L1X3 + To2X3
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Taking partial derivatives of the above functions results in the Jacobian matrix

2:61 —2:62 2.’133
J = ) r1 + 2:62 -3
1-— I3 I3 —r1 + T2

The following statements solve the given system of equations by the Newton-Raphson
algorithm

Dx=[10;10;10]; #Change in variable is set to a high value

x=[1; 1; 11; % Initial estimate
c=[11; 3; 6];

iter = 0; % Iteration counter
while max(abs(Dx))>=.0001 & iter<10; % Test for convergence
iter = iter + 1 % No. of iterations
F = [x(1)"2-x(2)"2+x(3) "2 % Functions

x(1)*x(2)+x(2) "2-3*x(3)
x(1)-x(1)*x(3)+x(2)*x(3)];

DC =C - F % Residuals
J = [2*xx(1) -2*x(2) 2*x(3) % Jacobian matrix
x(2) x(1)+2*x(2) -3
1-x(3) x(3) -x(1)+x(2)]
Dx=J\DC %Change in variable
x=x+Dx % Successive solution
end

The program results for the first iteration are

DC = J =
10 2 -2 2
4 1 3 -3
5 0 1 0
Dx = X =
4.750 5.750
5.000 6.000
5.250 6.250

After six iterations, the solution converges to z; = 2.0000, 2 = 3.0000, and 3 =
4.0000.

1.15 SIMULATION DIAGRAM

The differential equations of a lumped linear network can be written in the form
x(t) = Ax(t) + Bu(t) (1.1)
y(t) = Cx(t) + Du(t)

This system of first-order differential equations is known as the state equation
of the system, and x is the state vector. One advantage of the state-space method is
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that the form lends itself easily to the digital and/or analog computer methods of so-
lution. Further, the state-space method can be easily extended to analysis of nonlinear
systems. State equations may be obtained from an nth-order differential equation or
directly from the system model by identifying appropriate state variables.
To illustrate how we select a set of state variables, consider an nth-order linear
plant model described by the differential equation
d™y

i + ap-1

dn—ly

dy
W—{—...—{—al——i-aoy:u

t 1.2
- ® (12)
where y(t) is the plant output and w(¢) is its input. A state model for this system is
not unique, but depends on the choice of a set of state variables. A useful set of state
variables, referred to as phase variables, is defined as

1

. . n—
1 =Y, L2=Y, T3 =Y, ..., Tpn=1Y

We express & = z41 fork = 1,2,...,n—1, and then solve for d"y/dt", and
replace y and its derivatives by the corresponding state variables to give

:i?l = X2
ii?g = I3
(1.3)
Tp1 = Ip
Iy = —apT] —a1T2 — ... — Gp_1 Tp + u(t)
or in matrix form
i‘l 0 1 0 0 I 0
i‘g 0 0 1 0 9 0
= : : : Pl u®) (1.4)
i‘n—l 0 0 0 1 Tp—1 0
Ty —ap —ai —a9 —Qp_1 Tn 1
and the output equation is
y=1_[1 0 0 0]x (1.5)

The M-file ode2phv.m is developed which converts an nth-order ordinary differential
equation to the state-space phase variable form. [A, B, C] = ode2phv(ai, k) returns
the matrices A, B, C, where ai is a row vector containing coefficients of the equation
in descending order, and Kk is the coefficient of the right-hand side.

Equation (1.3) indicates that state variables are determined by integrating the
corresponding state equation. A diagram known as the simulation diagram can be
constructed to model the given differential equations. The basic element of the simu-
lation diagram is the integrator. The first equation in (1.3) is

iﬁ1:$2
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Integrating, we have

x1:/x2d$

The above integral is shown by the following time-domain symbol. The integrating
block is identified by symbol % Adding an integrator for the remaining state variables
and completing the last equation in (1.3) via a summing point and feedback paths, a
simulation diagram is obtained.

zo(t) z1(1)

» =

1.16 INTRODUCTION TO SIMULINK

SIMULINK is an interactive environment for modeling, analyzing, and simulating a
wide variety of dynamic systems. SIMULINK provides a graphical user interface for
constructing block diagram models using “drag-and-drop” operations. A system is
configured in terms of block diagram representation from a library of standard com-
ponents. SIMULINK is very easy to learn. A system in block diagram representation
is built easily and the simulation results are displayed quickly.

Simulation algorithms and parameters can be changed in the middle of a simu-
lation with intuitive results, thus providing the user with a ready access learning tool
for simulating many of the operational problems found in the real world. SIMULINK
is particularly useful for studying the effects of nonlinearities on the behavior of the
system, and as such, it is also an ideal research tool. The key features of SIMULINK
are

Interactive simulations with live display.

A comprehensive block library for creating linear, nonlinear, discrete or hybrid
multi-input/output systems.

Seven integration methods for fixed-step, variable-step, and stiff systems.

Unlimited hierarchical model structure.

Scalar and vector connections.

Mask facility for creating custom blocks and block libraries.

SIMULINK provides an open architecture that allows you to extend the simulation
environment:
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e You can easily perform “what if” analyses by changing model parameters —
either interactively or in batch mode — while your simulations are running.

e Creating custom blocks and block libraries with your own icons and user inter-
faces from MATLAB, Fortran, or C code.

e You can generate C code from SIMULINK models for embedded applications
and for rapid prototyping of control systems.

e You can create hierarchical models by grouping blocks into subsystems. There
are no limits on the number of blocks or connections.

e SIMULINK provides immediate access to the mathematical, graphical, and pro-
gramming capabilities of MATLAB, you can analyze data, automate procedures,
and optimize parameters directly from SIMULINK.

e The advanced design and analysis capabilities of the toolboxes can be executed
from within a simulation using the mask facility in SIMULINK.

e The SIMULINK block library can be extended with special-purpose blocksets.
The DSP Blockset can be used for DSP algorithm development, while the
Fixed-Point Blockset extends SIMULINK for modeling and simulating digital
control systems and digital filters.

1.16.1 SIMULATION PARAMETERS AND SOLVER

You set the simulation parameters and select the solver by choosing Parameters from
the Simulation menu. SIMULINK displays the Simulation Parameters dialog box,
which uses three “pages” to manage simulation parameters. Solver, Workspace 1/0,
and Diagnostics.

SOLVER PAGE

The Solver page appears when you first choose Parameters from the Simulation
menu or when you select the Solver tab. The Solver page allows you to:

e Set the start and stop times — You can change the start time and stop time for the
simulation by entering new values in the Start time and Stop time fields. The
default start time is 0.0 seconds and the default stop time is 10.0 seconds.

e Choose the solver and specify solver parameters — The default solver provide
accurate and efficient results for most problems. Some solvers may be more
efficient that others at solving a particular problem; you can choose between
variable-step and fixed-step solvers. Variable-step solvers can modify their step
sizes during the simulation. These are ode4S, ode23, odel13, odelSs, ode23s,
and discrete. The default is ode4S. For variable-step solvers, you can set the
maximum and suggested initial step size parameters. By default, these param-
eters are automatically determined, indicated by the value auto. For fixed-step
solvers, you can choose odeS, ode4, ode3, ode2, odel, and discrete.
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e Output Options — The Output options area of the dialog box enables you to
control how much output the simulation generates. You can choose from three
popup options. These are: Refine output, Produce additional output, and Pro-

duce specified output only.

WORKSPACE I/0 PAGE

The Workspace I/O page manages the input from and the output to the MATLAB

workspace, and allows:

e [oading input from the workspace — Input can be specified either as MATLAB

command or as a matrix for the Import blocks.

e Saving the output to the workspace —You can specify return variables by se-
lecting the Time, State, and/or Output check boxes in the Save to workspace

arca.

DIAGNOSTICS PAGE

The Diagnostics page allows you to select the level of warning messages displayed

during a simulation.

1.16.2 THE SIMULATION PARAMETERS DIALOG BOX

Table below summarizes the actions performed by the dialog box buttons, which ap-

pear on the bottom of each dialog box page.

Button Action

Apply  Applies the current parameter values and keeps the dialog box
open. During a simulation, the parameter values are applied
immediately.

Revert  Changes the parameter values back to the values they had
when the Dialog box was most recently opened and applies
the parameters.

Help Displays help text for the dialog box page.

Close Applies the parameter values and closes the dialog box. Dur-
ing a simulation, the parameter values are applied immedi-
ately.

To stop a simulation, choose Stop from the Simulation menu. The keyboard shortcut
for stopping a simulation is Ctrl-T. You can suspend a running simulation by choosing
Pause from the Simulation menu. When you select Pause, the menu item changes to

Continue. You proceed with a suspended simulation by choosing Continue.
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1.16.3 BLOCK DIAGRAM CONSTRUCTION

At the MATLAB prompt, type SIMULINK. The SIMULINK BLOCK LIBRARY, con-
taining seven icons, and five pull-down menu heads, appears. Each icon contains var-
ious components in the titled category. To see the content of each category, double
click on its icon. The easy-to-use pull-down menus allow you to create a SIMULINK
block diagram, or open an existing file, perform the simulation, and make any modi-
fications. Basically, one has to specify the model of the system (state space, discrete,
transfer functions, nonlinear ode’s, etc), the input (source) to the system, and where
the output (sink) of the simulation of the system will go. Generally when building a
model, design it first on the paper, then build it using the computer. When you start
putting the blocks together into a model, add the blocks to the model window before
adding the lines that connect them. This way, you can reduce how often you need to
open block libraries. An introduction to SIMULINK is presented by constructing the
SIMULINK diagram for the following examples.

MODELING EQUATIONS

Here are some examples that may improve your understanding of how to model equa-
tions.

Example 1.22

Model the equation that converts Celsius temperature to Fahrenheit. Obtain a display
of Fahrenheit-Celsius temperature graph over a range of 0 to 100°C.

9
Tr = ch + 32 (1.6)
First, consider the blocks needed to build the model. These are:
e A ramp block to input the temperature signal, from the source library.

e A constant block, to define the constant of 32, also from the source library.

A gain block, to multiply the input signal by 9/5, from the Linear library.

A sum block, to add the two quantities, also from the Linear library.

A scope block to display the output, from the sink library.

To create a SIMULINK block diagram presentation select new... from the File menu.
This provides an untitled blank window for designing and simulating a dynamic sys-
tem. Copy the above blocks from the block libraries into the new window by de-
pressing the mouse button and dragging. Assign the parameter values to the Gain and
Constant blocks by opening (double clicking on) each block and entering the appro-
priate value. Then click on the close button to apply the value and close the dialog
box. The next step is to connect these icons together by drawing lines connecting the
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/+ ]

Ramp Gain

32 +
Sum

Constant

FIGURE 1.10
Simulink diagram for the system of Example 1.22.

icons using the left mouse button (hold the button down and drag the mouse to draw
a line). You should now have the SIMULINK block diagram as shown in Figure 1.10.

The Ramp block inputs Celsius temperature. Open this block, set the Slope to 1,
Start time to 0, and the Initial output to 0. The Gain block multiplies that temperature
by the constant 9/5. The sum block adds the value 32 to the result and outputs the
Fahrenheit temperature. Pull down the Simulation dialog box and select Parameters.
Set the Start time to zero and the Stop Time to 100. Pull down the File menu and
use Save to save the model under simexa22 Start the simulation. Double click on the

Scope, click on the Auto Scale, the result is displayed as shown in Figure 1.11.

220 T T T T

180

140
Fahrenheit

100

60

20 20 40 60 80 100

Celsius

FIGURE 1.11
Fahrenheit-Celsius temperature graph for Example 1.22.

Example 1.23
Construct a simulation diagram for the state equation described by
d.’El
=
e~ 7
d.’EQ 1
E = M[f(t) - B.’Eg - k.’El]

where M = 1kg, B =5 N/m/sec, K = 25 N/m, and f(¢) = 25u(t).



1.16. INTRODUCTION TO SIMULINK 43

The simulation diagram is drawn from the above equations by inspection and is shown
in Figure 1.12.

F=25
] T 1 T2 1 Ty
. - 5 5
Step Input SLTm Integratorl Integrator2 Scope 1
b)
Gain?2 5 S cope 2
Gainl

FIGURE 1.12

Simulink diagram for the system of Example 1.23.

To create a SIMULINK block diagram presentation select new... from the File
menu. This provides an untitled blank window for designing and simulating a dynamic
system. You can copy blocks from within any of the seven block libraries or other
previously opened windows into the new window by depressing the mouse button and
dragging. Open the Source Library and drag the Step Input block to your window.
Double click on Step Input to open its dialog box. Set the step time to 0, and set the
Initial Value to 0 and the Final Value to 25 to represent the step input. Open the Linear
Library and drag the Sum block to the right of the Step Input block. Open the Sum
dialog box and enter + - - under List of Signs. Using the left mouse button, click and
drag from the Step output port to the Summing block input port to connect them. Drag
a copy of the Integrator block from the Linear Library and connect it to the output
port of the Sum block. Click on the Integrator block once to highlight it. Use the Edit
command from the menu bar to copy and paste a second Integrator. Next drag a copy
of the Gain block from the Linear Library. Highlight the Gain block, and from the
pull-down Options menu, click on the Flip Horizontal to rotate the Gain block by
180°. Double click on Gain block to open its dialog box and set the gain to 5. Make a
copy of this block and set its gain to 25. Connect the output ports of the Gain blocks
to the Sum block and their input ports to the locations shown in Figure 1.12. Finally,
get two Auto-Scale Graphs from the Sink Library, and connect them to the output of
each Integrator. Before starting simulation, you must set the simulation parameters.
Pull down the Simulation dialog box and select Parameters. Set the Start Time to
zero, the Stop Time to 3, and for a more accurate integration, set the Maximum Step
Size to 0.1. Leave the other parameters at their default values. Press OK to close the
dialog box.

If you don’t like some aspect of the diagram, you can change it in a variety of
ways. You can move any of the icons by clicking on its center and dragging. You
can move any of the lines by clicking on one of its corners and dragging. You can
change the size and the shape of any of the icons by clicking and dragging on its
corners. You can remove any line or icon by clicking on it to select it and using the
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cut command from the edit menu. You should now have exactly the same system as
shown in Figure 1.12. Pull down the File menu and use Save as to save the model
under a file name simexa23. Start the simulation. SIMULINK will create the Figure
windows and display the system responses. To see the second Figure window, click
and drag the first one to a new location. The simulation results are shown in Figures
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1.13 and 1.14.

SIMULINK enables you to construct and simulate many complex systems, such
as control systems modeled by block diagram with transfer functions including the
effect of nonlinearities. In addition, SIMULINK provides a number of built-in state

variable models and subsystems that can be utilized easily.

1.2
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FIGURE 1.13
Displacement response of the system described in Example 1.23.
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FIGURE 1.14
Velocity response of the system described in Example 1.23.
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FIGURE 1.15
Simulation diagram for the system of Example 1.24.

Example 1.24
Consider the system defined by

dy Py | dy
2— +4— +8— + 10y = 10u(t
s e T8 T = 10u()
We have a third-order system; thus there are three state variables. Let us choose the
state variables as

=Y
:EQZ:Q
r3 =

Then we obtain

.’13.1 = T2
15.2 = I3
.’13.3 = —5.’131 - 4.’132 — 2.’133 + 5u(t)

The last of these three equations was obtained by solving the original differential

equation for the highest derivative term 3 and then substituting y = 1, = 2, and
1y = x3 into the resulting equation. Using matrix notation, the state equation is

x1 0 1 0 T 0
Ty | = 0 0 1 zo |+ | 0 | u(t)
1:3 -5 —4 -2 I3 5

and the output equation is given by
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The simulation diagram is obtained from the system differential equations and is given
in Figure 1.15.

A SIMULINK Block diagram is constructed and saved as simexa24. The simu-
lation response is shown in Figure 1.16.

1.4
1.2
1.0
0.8
0.6
0.4
0.2

0

FIGURE 1.16
Simulation result for the system in Example 1.24.

Example 1.25

Use the state-space model to simulate the state and output equations described in Ex-
ample 1.24.

The State-Space model provides a dialog box where the A, B, C', and D matri-
ces can be entered in MATLAB matrix notation, or by variables defined in Workspace.
A SIMULINK diagram using the State-Space model is constructed as shown in Figure
1.17, and saved as simexaZ25.

Su(t)

[ EE B
Step Input State-space Scope
FIGURE 1.17

State-space model for system in Example 1.25.

Note that in this example, the output is given by y = x1, and we define C' as
C=1[1 0 0].Ifitis desired to access all the states, then we can define C as an
identity matrix, in this case a third order, i.e., C = eye(3), and D as D = zeros(3, 1).
The output is a vector of state variables. A DeMux block may be added to produce
individual states for graphing separately.
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1.16.4 USING THE TO WORKSPACE BLOCK

The To Workspace block can be used to return output trajectories to the MATLAB
Workspace. Example 1.26 illustrates this use.

Example 1.26

Obtain the step response of the following transfer function, and send the result to the
MATLAB Workspace.
C(s) 25

R(s) s2+2s54+25

where 7(t) is a unit step function. The SIMULINK block diagram is constructed and
saved in a file named simexa26 as shown in Figure 1.18.

u(t)

25 ¢
52425425

Step Input To Work
°p 1Pt Transfer Fcn 0 yvorkspace
: t
Clock 15 Workspace
FIGURE 1.18

Simulink model for system in Example 1.26.

The To Workspace block can accept a vector input, with each input element’s
trajectories stored as a column vector in the resulting workspace variable. To specify
the variables open the To Workspace block and for the variable name enter c. The
time vector is stored by feeding a Clock block into To Workspace block. For this block
variable name specify ¢. The vectors c and ¢ are returned to MATLAB Workspace upon
simulation.

1.16.5 LINEAR STATE-SPACE
MODEL FROM SIMULINK DIAGRAM

SIMULINK provides the linmod, and dlinmod functions to extract linear models from
the block diagram model in the form of the state-space matrices A, B, C, and D. State-
space matrices describe the linear input-output relationship as

z(t) = Az(t) + Bu(t) 1.7)
y(t) = C(t) + Du(t) (1.8)
The following Example illustrates the use of linmod function. The input and

outputs of the SIMULINK diagram must be defined using Inport and Outport blocks
in place of the Source and Sink blocks.
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Example 1.27

Obtain the state-space model for the system represented by the block diagram shown
in Figure 1.19. The model is saved with a filename simexa27. Run the simulation and
to extract the linear model of this SIMULINK system, in the Command Window, enter

the command
O,

542 T 20
0 s+1 + s24+10s+16
C Plant Intg. Out

W |=

In ontroller

Suml

Gain

FIGURE 1.19
Simulink model for system in Example 1.27.

[A,B,C,D] = linmod(’simexa27’)

The result is

0 0 0 20 0
-1 -1 0 0 1
-1 1 -10 -56 1
0 0 1 0 0
¢ =
1 0 0 0
D =

0

In order to obtains the transfer function of the system from the state-space model, we
use the command

[num, den]l=ss2tf(A, B, C, D)

the result is

num
0.0000 0.0000 0.0000 20.0000 40.0000

den
1.0000 11.0000 66.0000 76.0000 40.0000
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Thus, the transfer function model is

_ 20s + 40
st 4 1183 4 6652 + 765 + 40

T(s)

Once the data is in the state-space form, or converted to a transfer function model,
you can apply functions in Control System Toolbox for further analysis:

e Bode phase and magnitude frequency plot:

bode(A, B, C, D) or bode(num, den)

e Linearized time response:

step(A, B, C, D) or step(num, den)
1sim(A, B, C, D) or lsim(num, den)
impulse(A, B, C, D) or impulse(num, den)

1.16.6 SUBSYSTEMS AND MASKING

SIMULINK subsystems, provide a capability within SIMULINK similar to subpro-
grams in traditional programming languages.

Masking is a powerful SIMULINK feature that enables you to customize the
dialog box and icon for a block or subsystem. With masking, you can simplify the use
of your model by replacing many dialog boxes in a subsystem with a single one.

Example 1.28

To encapsulate a portion of an existing SIMULINK model into a subsystem, consider
the SIMULINK model of Example 1.24 shown in Figure 1.20, and proceed as follows:

1. Select all the blocks and signal lines to be included in the subsystem with the
bounding box as shown.

2. Choose Edit and select Create Subsystem from the model window menu bar.
SIMULINK will replace the select blocks with a subsystem block that has an
input port for each signal entering the new subsystem and an output port for
each signal leaving the new subsystem. SIMULINK will assign default names
to the input and output ports.

To mask a block, select the block, then choose Create Mask from the Edit menu.
The Mask Editor appears. The Mask Editor consists of three pages, each handling a
different aspect of the mask.
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FIGURE 1.20
Simulation diagram for the system of Example 1.24.
Su(t)
T
Inl Outl
Ste Scope
P Subsystem
FIGURE 1.21

Simulation diagram for the system of Example 1.24.

e The Initialization page enables you to define and describe mask dialog box pa-
rameter prompts, name the variables associated with the parameters, and spec-
ify initialization commands.

e The Icon page enables you to define the block icon.

e The Documentation page enables you to define the mask type, and specify the
block description and the block help.

In this example for icon the system transfer function is entered with command
dpoly([10], [2 4 8 10])

A short description of the system and relevant help topics can be entered in the Doc-
umentation page. The subsystem block is saved in a file named simexa29.
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